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If printed, this tutorial is best viewed in color. Black-and-white copies will be 
hard to read because of the dark backgrounds of the Final Cut Pro X 
interface. 



Final Cut Pro X Tutorial • PAGE 2 of 139 
 

JOE BLUM • Syracuse University • jeblum01@syr.edu 
 

Table of Contents 

1. Getting Started .............................................................................3 
 

1.1 File Management & Workflow ............................................................3 
 

1.2 Setting Up Your Assignment ..............................................................5 
 
1.3 Importing AVCHD Footage ...............................................................15 
 
1.4 Importing HDSLR Footage ...............................................................23 
 
1.5 Importing Other Media Files ............................................................29 
 
1.6 Organization ....................................................................................32 

 

2. Editing the Assignment ...............................................................40 
 

2.1 Editing Basics & Transitions.............................................................40 
 
2.2 Audio Basics ....................................................................................55 
 
2.3 Background Tasks............................................................................60 
 
2.4 Text Elements ..................................................................................62 
 
2.5 Additional Editing Helpers................................................................71 

 

3. Fine-Tuning.................................................................................75 
 

3.1 Audio Expanded ...............................................................................75 
 
3.2 Visual Editing Expanded...................................................................87 
 
3.3 Video Color Correction ...................................................................118 

 

4. Finishing Up..............................................................................126 
 

4.1 Sharing ..........................................................................................126 
 
4.2 Reconnecting Broken Links............................................................131 
 
4.3 Recovering Missing Projects and Events ........................................135 

 



Final Cut Pro X Tutorial • PAGE 3 of 139 
 

JOE BLUM • Syracuse University • jeblum01@syr.edu 
 

Getting Started 
File Management & Workflow 

Before you start 

It is recommended that you quit all other programs. Also, it is often good to 
restart your computer. 

Store your assets on an external hard drive 

When working in Final Cut Pro X (FCPX) in a Newhouse lab, it is best NOT to 
store all your assets (photos, audio, video, etc.) on the computer’s hard 
drive (where your FCPX application resides). Space-wise, bigger is better. 
For connecting to an external drive, Firewire 800 is strongly preferred over 
Firewire 400 or USB. 
 
You will use your own hard drive for ALL class assignments. 
 

Workflow Summary 

1. Create the Assignment Materials folder and subfolders for your assets. 
Don’t skip this step. 
2. Launch Final Cut Pro X and set up your project. 
3. Import files. 
4. Organize assets (log, rating, keyword). 
5. Edit your assignment.  
6. Sweeten the audio. 
7. Correct color. 
8. Add any effects or motion. 
9. Add text elements. 
10. Share (export your video). 
 

Create an Assingment Materials Folder 

On your external hard drive, create a folder to contain all the elements of 
your assignment. Inside that folder, you will make a set of subfolders to 
store all your assignment elements.. Why? 
 
a. This keeps you organized so you know what and where your assets are.  
b. Final Cut Pro X needs to keep track of where your assets are located. 
c. A single master folder simplifies transferring and backup of your project. 
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So, create an Assignment Materials folder on your external hard drive. 
 
Depending on the class and your instructor, there are three different naming 
conventions: 
 
1. TEAM NAME - ASSIGNMENT NAME 
Example: TEAM A - FICTION 
 
2. LAST NAME - ASSIGNMENT NAME 
Example: SMITH - FICTION 
 
3. DATE (year first) - ASSIGNMENT - YOUR NAME 
Example: 2012_06_21_FICTION_JOHNSMITH 
 
Please ask your instructor on which naming convention you should use. 
 

Create Subfolders inside your Assignment Materials folder 

 

AUDIO: Any sound that is not captured with your video, i.e. sound bites, 
sound effects, music. 
GRAPHICS: Any files that will be used for design within your assignment, 
i.e. After Effects, Motion, Illustrator, Photoshop, etc. 
OUTPUT: Where FCPX will share your finished movie to. 
PHOTO: All photographs that relate to your assignment, either created by 
you or a third party. 
TEXT: Documents that are used in the creation of your assignment, i.e. 
proposals, storyboards, evaluations, etc. 
VIDEO: All video content used for your assignment. 
WEB PROJECT: Any files and documents used to create web content related 
to the assignment. 
 
IMPORTANT: Everything related to your assignment should be stored and 
saved into this Assignment Materials folder. Once you start your 
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assignment, changing the names of folders or files already imported into 
Final Cut Pro X will require that you reconnect those items. 
(See Chapter 3.2 for more information on how to reconnect clips.) 

Subfolders for video and photo 

 

When shooting video or photographs over multiple days and with different 
cameras, create subfolders to further organize your assignment materials. 
Use the date of the shoot as the subfolder's name. Inside that folder create 
separate subfolders for each camera used. 
 
This ensures that your files will not be overwritten when you shoot additional 
material for your assignment. 
 
 

Setting Up Your Assignment 

Follow these steps BEFORE you import content into FCPX and begin editing. 
You need to ensure the following settings are correct in order for your 
assignment to be properly and safely stored on your hard drive. 

Setting Preferences 

 

Launch Final Cut Pro X. Select Preferences from the Final Cut Pro menu. It 
will bring up this menu: 
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Preferences: Editing 

 

Under the Editing icon, make sure the settings are the same as shown 
above. Then click on the Playback icon to move on to the next set of 
preferences. 
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Preferences: Playback 

 

Match up the settings to the ones in the image above: 
1. Check background render and change "Start after" to 60 seconds. 
2. Click on "Use original or optimized media" and set "Playback Quality" to 
Better Performance. 
3. Check "Create optimized media..." and "Warn when frames are 
dropped...". 
 
Then click on the Import icon to move on to the next set of preferences. 
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Preferences: Import 

 

Match up the settings to the ones in the image above: 
1. Organizing: Only check "Import folders as Keyword Collections." 
2. Transcoding: Keep both boxes unchecked.  
3. Video: Keep all boxes unchecked. 
4. Audio: Check "Separate mono and group stereo audio" and "Remove 
silent channels." 
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Preferences: Destinations 

 

The Destinations menu is used to manage the Share settings that you will be 
using in Section 4.1. 
 
Match up the settings to the ones in the image above: 
1. Select the Master File (default). 
2. Format: Video and Audio  
3. Video codec: H.264. 
4. Open with: QuickTime Player (default). 
 
Close the Preferences menu by selecting the red circle in the upper left 
corner. 
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Your Work Space 

 

This is the default layout for FCPX. 

EVENTS 
Events are a collection of video, audio and stills. You will create a new Event 
for each assignment. 

Creating an Event 

 

IMPORTANT: Remember, you want your entire Assignment to be on an 
external hard drive.  
 
To do this: 
1. Highlight your external hard drive in the Event Library BEFORE creating 
your new Event. 
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2. Go to the Top Menu and select File and New Event. 
 
The Event Library shows all of the different events you are working on.  
 
The Event Browser displays your video, audio and photographs for you to 
choose when editing your assignment. 

Naming Your Event 

 

1. Name your event the same as your Assignment Materials folder: 
 
IMPORTANT: Use the naming convention that your class instructor 
has designated such as... 
 
TEAM NAME - ASSIGNMENT NAME    
or    
YOUR NAME - ASSIGNMENT NAME   
or   
DATE - ASSIGNMENT - YOUR NAME 
 
IMPORTANT: Make sure the EVENT appears underneath your External Hard 
Drive and NOT the Macintosh HD. 
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PROJECTS 
Projects are where you will be editing your assignment. Each Project will 
have a Timeline that will allow you to place video, audio and photographs in 
the order you so desire. 

Creating a Project 

 

 
 
1. Right Click on your external drive and select New Project. 
          -You can also go to the top menu and select File and New Project. 

 -You can also select the New Project icon on the bottom of the Project 
   Library. 

 
IMPORTANT: Like you did with Events, you must create each Project on 
your External Hard Drive. Make sure your drive is highlighted in the Project 
Library. 

 

2. Once you select New Project, a drop-down menu (shown above) will 
appear. You will name the project: 
 
TEAM NAME - ASSIGNMENT NAME - FIRST EDIT 
 
It is a good idea to make different versions of your projects so you can track 
the progress of your assignment. You can start with FIRST EDIT then name 
your next Project version SECOND EDIT, THIRD EDIT, etc., until FINAL EDIT. 
 
NOTE: Check with your instructor to see what naming convention you 
should use. 
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3. You must assign your project to an Event. Select the Event for the 
Assignment that you are working on.  
 
For Example: If you are working on the Fiction Assignment, then you would 
select the TEAM NAME - FICTION Event for your TEAM NAME - FICTION - 
FIRST EDIT Project. 
 
4. Select "Use Custom Settings." 

 

5. Video Properties: Select Custom and change the settings to match the 
above image: 
 
Format: 1080p HD 
Resolution: 1920x1080 
Rate: 29.97p 
 
6. Audio and Render Properties: Use Default Settings 
 
7. Click "OK" 
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Project Library 

 

Your Project Library will now look like this. When you have more projects, 
they will show up as individual rows. 
 
To toggle between the Project Library View and the Timeline view, click on 
the film canister icon in the bottom left of the window. 

Where things are on your hard drive 

 

When you create Events and Projects within FCPX, two folders are 
automatically created in the root menu of your hard drive: Final Cut Events 
and Final Cut Projects.  
 
These MUST stay in the top menu of your hard drive. DO NOT move these 
folders around your hard drive, or Final Cut will not be able to find your 
Events or Projects. 
 
IMPORTANT: Do not add files to or remove files from these folders. It is 
best to leave this files alone in order to prevent your events and projects 
from being lost or corrupted and to ensure FCPX is working properly. 
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Importing AVCHD Footage 

This section explains how to take the footage from your camera (in the 
AVCHD format), store it safely on your hard drive and then import it into 
Final Cut Pro X. The specific camera being used for this guide is the Canon 
Vixia HF M41. All other Vixia models as well as the Sony NEX-5U use the 
AVCHD file format. 

BEFORE IMPORT 
Before you launch FCPX and start importing your video, you will copy the 
files onto your external hard drive first. This will create a backup of your 
video for when you return a loaner camera and in the event that the files are 
erased. 

Copying footage from the camera to your hard drive 

Caution: Follow these instructions carefully or risk losing your footage. 
 
1.   Plug the camera into an electrical outlet using the cables that came with 
your camera kit. Use the DC IN 8.4V plug on the back of the camera. 
 
2.   Connect the camera to the computer using the provided USB cable. The 
large end of the USB cable goes into the back of the computer, not the 
keyboard, and the small end connects to the camera under the hand strap 
(or on the inside of the screen, depending on the model). 
 
3.   Turn on the video camera and select the playback mode.  
 
• On the HF10, turn the main dial to the blue video camera icon for 

playback. 
• On the HF20, just push the playback button on the lower right side of the 

camera’s flip out screen. 
• On the HF31 and HF41, press the video camera to playback symbol on 

the inside of the flip out screen. 
 
4.   Use your finger (or the camera’s flip-out screen’s joystick on the 10/20) 
to select the Built-in Memory (Computer/Printer on HF 10/20) option on the 
screen. Be sure to push SET to activate the connection. 
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5.  The camera will appear on your desktop like an external hard drive. 
Do not disconnect the USB cable or power source while the video camera is 
connected to the computer.   
 
6. The AVCHD folder is where all your video footage is stored. 
 
7. If you also shot photos with the video camera, you will see the DCIM 
folder as well. Your photos are stored inside the DCIM folder. 
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8. You will now drag the ENTIRE AVCHD folder from the CANON drive onto 
your External Hard Drive and place it into the subfolder you created inside 
the VIDEO folder in your Assignment Materials folder. 
 
IMPORTANT: Do NOT pull out individual files from the AVCHD folder! You 
need the entire AVCHD folder in order for FCPX to import your video. 
 
9. If you shot photos with your video camera you'll also want to copy the 
DCIM folder to your external hard drive, in the PHOTO folder of your 
Assignment Materials folder. 
 
10. That done, eject the CANON hard drive the same way you eject an 
external hard drive. 
 
11. Disconnect and shut down the video camera. 
 
At this point, your video footage is stored on your external drive. Now it is 
time to import your footage into FCPX. 

IMPORT 
Once you have copied all of your AVCHD footage to your external drive you 
can now open FCPX. 
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Import Media 

 

1. Select the Event on your external hard drive for the assignment that you 
are importing video for.  
 
For AVCHD footage you will need to select Import Media. If you have not 
imported anything yet, you can select it from the Event Browser window or 
select "File" and "Import Media (Command I)." 
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2. Under "Devices," select your External Hard Drive. 
 
3. Navigate to your Assingment Materials Folder. 
 
4. Under the VIDEO Subfolder, select the subfolder for the date you wish to 
import. 
 
5. Select the subfolder that contains your AVCHD folder. The video clips will 
now appear in list form. 
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6. A selected clip will allow it to be viewed in the Viewer Window. 
You can play the clips and decide which ones to import.  
 
7. Select multiple clips by holding the Command key and selecing each clip.  
 
8. When you've finished selecting the clips you want, click Import 
Selected. 
 
Note: If you prefer, you can select all the clips at once by holding down the 
Shift key and clicking and dragging on all of the clips. Then click Import All.  
This will import all your footage but might take a while to complete 
depending on the amount of footage you shot. 
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Once you select Import, this drop-down window will appear. Make sure your 
settings match the ones above: 
 
5. Select "Add to existing event." Select the event for the specific 
assignment you are working on. 
 
6. Transcoding: uncheck both options. 
 
7. Video: uncheck all options. 
 
NOTE: You can always change these settings later if you need to. 
Unchecking these options will reduce the time it takes to import your 
footage. 
 
8. Audio: Check "Separate mono and group stereo audio" and "Remove 
silent channels." 
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9. Click Import. 

 

Once Import is clicked, the Import Window will close and the clips will 
appear in the Event Browser. 
 
10. The status of the import process will appear as a circle being filled in 
with white. Once the clip is finished being Imported, the circle will disappear.  
 
You may now start organizing the clips in the Event Browser. 
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Importing HDSLR Footage 

This section explains how to take the footage from your HDSLR camera, 
store it safely on your hard drive and then import it into Final Cut Pro X. Use 
this guide for footage shot on any HDSLR, such as Canon and Nikon 
cameras. For importing files from an AVCHD file format camera please see 
section 1.3. 

BEFORE IMPORT 
Before you enter FCPX and start importing your video, you will copy the files 
from the memory card onto your external hard drive first. You NEVER want 
to import your footage directly from the memory card. 
 
Note: It is always best to copy your video files onto multiple hard drives. 
Too often a working hard drive crashes just before finishing a major project, 
wiping out not only editing work, but also raw video. Redundancy is the best 
policy. Make backups. 

Copying footage from the memory card to your hard drive 

 

The following lesson is based on the Canon 7D camera. This process will be 
the same for all HDSLR cameras. However, the folder organization on your 
memory card may be different depending on what camera you are using. 
 
1. Connect the memory card to the computer using a card reader or by 
connecting the camera via USB. 
 
2.  The video files are located within the DCIM folder. 
 
3. The video files are designated by the .MOV suffix. 
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4. Select only the .MOV files. FCPX does not need the .THM files. This can be 
done by holding down the Command key and clicking on the desired files. 
 
5. Drag the selected files onto your External Hard Drive and place it into the 
subfolder you created inside the VIDEO folder in your Assignment Materials 
folder. 
 
6. Wait until all of the files have copied over. 
 
7. When all the files have copied over to your External Hard Drive, eject the 
memory card from the computer. 
 
At this point, your video footage is stored on your external hard drive. Now 
it is time to import your footage into FCPX. 
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IMPORT 
Once you have copied all of your .MOV files to your external drive you can 
now open FCPX. 

Import Files 

 

1. Select the Event for the assignment that you are importing video files for. 
 
2. In the top menu select File > Import > Media. You can use the keyboard 
shortcut Command + I. 
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3. Under DEVICES select your External Hard Drive. 
 
4. Navigate to your Assignment Materials Folder. 
 
5. Navigate to the Video subfolder that contains the .MOV files. You can 
either select individual files or you can select the entire folder(s) that contain 
the files (as shown above). 
 
6. Click "Import Selected." 
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7. Select "Add to existing event." Select the event for the specific 
assignment you are working on. 
 
8. Organizing: check "Import folders as Keyword Collections." 
 
9. Transcoding: uncheck both options. 
 
10. Video: uncheck all options. 
 
11. Audio: Check "Separate mono and group stereo audio" and "Remove 
silent channels." 
 
12. Click "Import." 
 
Your video files will now appear in the Event Browser in FCPX. 
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The Folder names now appear as Keywords underneath the selected Event in 
the Event Library. 
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Importing Other Media Files 

In addition to importing AVCHD video, you may need to import additional 
media into FCPX, such as photographs and audio files. 
 
Before importing, all assets must be in your Assignment Materials 
folder within their respective subfolders i.e., AUDIO, PHOTO and 
GRAPHICS. 

Import Files 

 

1. In the top menu, select File > Import > Media. 
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2. In the Import window select the files you want to import. In the scenario 
shown above, selecting PHOTO will import the entire PHOTO folder.  
 
3. Click "Import Selected." 
 
 
IMPORTANT: Only import files that are located within your Assignment 
Materials folder on your External Hard Drive. Importing files from your 
desktop or other directories will disconnect them from the FCPX project 
during future edits. 

 

4. Select "Add to existing event." Select the event for the specific 
assignment you are working on. 
 
5. Organizing: check "Import folders as Keyword Collections." 
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6. Transcoding: uncheck both options. 
 
7. Video: uncheck all options. 
 
8. Audio: Check "Separate mono and group stereo audio" and "Remove 
silent channels." 
 
9. Click "Import." 
 
Your files will now appear in the Event Browser in FCPX. 
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Organization 

Final Cut Pro X has some great features to organize your media. This section 
will show a few ways to view your assets as well as Rating your clips and the 
basics of adding Keywords. 

The Event Browser 

 

Once you have imported your media it will show up in your Event Browser. 
There are many ways to view and group your media.  
 
If you do not see any media or the specific clips you are looking for, make 
sure you highlight the Event in the Event Library. 
 
In the screen above, the clips are displayed in Filmstrip View and the media 
is grouped by the date the content was created. 
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Changing Browser to List View 

 

1. Click the List View icon.  
 
The Event Browser displays in List View, with details on the length of the 
clip. 
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Changing how clips are grouped 

 

To change how the clips are grouped, click on the Tasks icon on the bottom 
of the Event Library.  
 
Under Group Clips By you can select the properties for how your clips 
appear in the Event Browser. 

RATINGS 

 

Ratings are an easy way to apply labels to a single clip, a group of clips or 
even just a portion of a clip. This can help you in finding the exact clips or 
part of a clip that you want to use.  
Ratings are located in the Tools section of the toolbar. 
 
There are three ratings: 
1. Favorite (green star). 
2. No rating (clear star). 
3. Rejected rating (red "X"). 
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Favorite an entire clip 

 

1. Highlight the clip in the browser. 
 
2. Click on the Green star. Click on the arrow to the left of the clip to reveal 
that you have designated it as a Favorite.  
 
3. A green bar will appear at the top of the clip. 
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Reject an entire clip 

 

If there is a clip that you don't want to use, you can apply a Rejected rating 
to it: 
 
1. Highlight the clip in the browser. 
 
2. Click on the Red "X". Click on the arrow to the left of the clip to reveal 
that you have rejected the clip. 
 
3. A red bar will appear at the top of the clip. 
 
NOTE: You can remove a Favorite or a Rejected label by highlighting the clip 
and clicking the Clear star. 
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Favorite a portion of a clip 

 

You can Favorite a portion of your clip: 
 
1. Click and drag your cursor over the part of the clip you like, creating a 
selection, then click on the Green star.  
 
2. Rename the Favorite by clicking on the name until the cursor opens up. 
This can help you identify why you selected that part of the clip. 
 
3. Now only a Green bar will appear in the portion of the clip that was rated 
as Favorite. 
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Sort Clips 

 

You can easily sort through the clips you have rated. 
 
1.  Select the drop-down menu on the top left of the Event Browser.  
This lets you view clips by the label they have been given.  
The default is All Clips.  
 
NOTE: If you ever have trouble finding a certain clip, make sure the correct 
label is selected to view. 

KEYWORDS 
Keywords can be added to any clip. They allow clips to be categorized and 
easily searchable. You can create as many keywords as you like. Keywords 
can be a very complex tool, but we'll look at a simple way to use them. 
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Creating Keywords 

 

1. Highlight a clip in the Browser. 
 
2. Click on the Key icon in the toolbar. 
 
3. Type in a word that you want to associate with that clip. 
 
4. Now the keyword will show up underneath your Event in the Event 
Library.  
All Keywords will have the Key icon next to them.  
By clicking on a keyword, you will only see the clips associated with that 
word. 
 
Suggested Keywords: 
 
• B-Roll 
• Interview 
• Scene 1, 2, etc. 
• Location (Farmers Market, Studio, Park, etc.) 
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Editing the Assignment 
Editing Basics & Transitions 

The Project Timeline is where you build your assignment. Clips with both 
video and audio are colored blue, while audio only is colored green. 

VIEW CLIPS IN THE EVENT BROWSER 
You can preview your clips in the Event Browser before you start editing the 
clips in the timeline. 

 

1. Select the clip you want to preview. 
 
2. The clip will now appear in the Viewer. 
 
3. Press the play icon in the Viewer OR press the SPACE BAR on your 
keyboard to play the clip. 

Skimmer 

A great way to quickly go through your clip is the Skimmer tool.  
 
 
• When you hover your cursor over a clip, it will automatically play in the 

viewer.  
• This allows your cursor to play back a clip in the viewer without having to 

press buttons on a mouse.  
• The clip can be in either the Event Browser OR the Timeline. 
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The Skimmer can be controlled by clicking on the Skimmer icons on the right 
side of the Timeline. 
 
1. This button turns skimming on and off. It is turned on when blue, off 
when it is gray. 
 
2. This button turns only audio skimming on and off. It is turned on when 
blue, off when it is gray. 

Selecting a clip 

Often times you will not need the entire clip. You can select just a portion of 
the clip to be used in the Timeline. 

 

1. Select the clip in the Event Browser. A Yellow frame will appear around 
the clip. 
 
2. You can then drag the ends of the yellow frame to change the exact 
selection within the clip. The time listed in the box shows the length of the 
new selection. 
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3. Also, you can select a portion of a clip by using IN and OUT points. 
   a. Move your cursor to where you want your clip to begin. Press the letter 
"I" on your keyboard. 
 
   b. Move your cursor to where you want your clip to end. Press the letter 
"O" on your keyboard. 
 
   c. A yellow frame will now designate the area of the clip you have 
selected. 

ADDING CLIPS TO THE TIMELINE 
There are several ways in which to take a clip from the Event Browser and 
place it into the timeline of your Project. 

Drag and Drop 

 

The easiest way to move a clip from the Event Browser into the Timeline is 
to drag and drop.  
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1. Select the clip in the Event Browser. The Hand icon will appear over the 
selection you have made. 
2. Click and drag the clip down to the timeline. When you unclick the mouse, 
the clip will stay in the timeline area. 

 

Edit Buttons 

On the left side of the toolbar are three buttons that help you get clips from 
the Event Browser into the Timeline. 

 

The buttons are, from left to right: 
 
1. Connect - Connects a clip to another clip already on the Timeline. The 
new clip will appear above the other clip. 
 
2. Insert - Inserts a clip into the Timeline wherever the playhead is. 
 
3. Append - Places the clip at the end of your Timeline. 
 
You will use the first two buttons later on in this tutorial, but for now start 
with the Append button. 
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Append Button 

 

 
 
 
 
 
 
 
 
 
 
 
1. Select your clip in the Event Browser. 
 
2. Press the Append Button OR use the keyboard shortcut E. 
 
3. The clip will now appear at the end of your timeline. 

 

TOUR AROUND THE TIMELINE 
FCPX has a Magnetic Timeline. That means that as you move a clip around 
the timeline, all the other clips will get out of the way and allow you to place 
the clip where you want, without moving the other clips first. 

Storyline 
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The Storyline is the dark gray area of your timeline in which your clips sit.  

Playhead 

 

The Playhead is the gray triangle on the top of the Timeline. Wherever the 
playhead is positioned, you will see that part of your project in the Viewer. 

Dashboard 

 

The Dashboard, located in the center of the Toolbar, just above the timeline, 
displays the timecode associated with the Timeline. 
(Hours/Minutes/Seconds/Frames). 

Snapping 

 

The Snapping tool snaps clips together. You can toggle it on and off with the 
keyboard shortcut, N. 
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Clip Appearance 

 

On the bottom right of the Timeline you can adjust how your clips appear in 
the timeline. 
 
1. Click on the light switch icon to open the window. 
 
2. You can change how big the audio waveforms appear compared to the 
video thumbnails. 
 
3. This allows you to change how big the video clips are in the Timeline. 
 
4. Keep Show Connections checked. 
 
5. This allows you to change what naming information the clips display in the 
Timeline.  
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Timeline Index 

 

The Timeline Index displays the clips in the Timeline on the left side of the 
screen. This can be toggled to show or hide. 
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Editing Tools 

 

There are various editing tools that will help you edit your assignment.  
 
We will discuss a few of these tools at various points during this tutorial. 
 
The tool you will use most often is the Select tool. You can choose it from 
the menu, or by the keyboard shortcut A. 

EDITING ON THE TIMELINE 
There is no "right" way to edit on the timeline. Some people prefer all of 
their clips lined up on one storyline, as seen here: 

 

Others prefer to stack clips, as seen here: 
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In time, you will develop your own way of editing, but it is best not to stack 
too many clips until you're more comfortable with editing with FCPX. 

Adjusting length of clip 

 

Once you have clips on the Timeline, you change the length of a clip by 
doing the following: 
 
1. Press the A key to be sure you are in the Select tool. 
 
2. When your cursor hovers over the end of a clip, then cursor will change to 
the Ripple icon, which is a small horizontal filmstrip. 
 
3. Click on the end of the clip and drag it left or right to change the length of 
that clip. The end of the clip will be highlighted yellow.  
 
4. The dialogue box will show much time you have added or taken away 
from the clip. 
 
5. Another option is the Blade Tool to cut a clip. Press B to get the blade and 
click the point on the clip to split it into two separate clips. 
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TRANSITIONS 
A transition is a change from one clip to the next clip. There are many 
transitions available to you, so we will highlight two examples here. 

Straight Cuts 

 

Straight Cut: when two clips are side by side on the Timeline, creating an 
instant change from one shot to the next. 
 
Note: This is the most commonly used transition in video editing. 

Dissolves 

 

Dissolve: when one clip fades out while the other clip fades in, blending the 
two images together briefly during the transition. 
 
Note: Dissolves are most commonly used to convey a change in time or 
place between two clips. 
 
There are many ways to add a dissolve to your project. We will look at a 
couple ways below: 
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Applying a Dissolve via the Transitions Menu 

 

1. Select the Transition icon in the Media Browser on the right side of the 
Toolbar. 
 
2. In the Transitions window below, select the Dissolves menu item. 
 
3. Click on the Cross Dissolve and drag it into your Timeline. 
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4. Drop the Cross Dissolve between the two clips you want to transition 
between. 
 
5. You can adjust the length of the dissolve by clicking on the edge of the 
transition and dragging left or right. 
 
• The default length is 1 second. 
• You can make the dissolve longer or shorter. 
 
Note: All dissolves require underlying handles (extra footage) that the clip 
can fade out of and into. If you place the dissolve at the very end and very 
beginning of neighboring clips, you will get a dialogue box, as seen below: 

 

By clicking on "Create Transition," FCPX will automatically trim each clip so 
there is enough footage to overlap and create the Cross Dissolve. 
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Applying a Cross Dissolve by Right Clicking 

 

A quick way to add a Cross Dissolve without going to the Transition Browser: 
 
1. Right Click on the point where two clips join together. 
2. Select "Add Cross Dissolve" or press Command + T on the keyboard. 
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Fade In/Fade Out 

Fade In:                                          Fade Out: 
 

 
 

 
Cross Dissolves can also be used at the beginning or end of your project to 
Fade In from black, or Fade Out from black. 
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Audio Basics 

You can do a lot to adjust and enhance your audio in Final Cut Pro X. We will 
look at a few basics here and explore more advanced options in Section 3.1. 

Audio Meter 

 

The Audio Meter is located in the Dashboard on the right side.  
 
Click on the icon to open up the Audio Meters that will appear larger to the 
right of your Timeline. 
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As the audio plays on your timeline, the bars represent the decibel level of 
the audio. The meter shows you how loud your audio actually is in the left 
and right channels. 
 
IMPORTANT: Audio levels must NEVER approach 0 dB. If it does it will be 
distorted and not sound professional. A red line will appear if your audio is 
too high. 
 
• Keep audio levels between -12 and -6 dB for conversational dialogue with 

a character or interview subject. 

Waveforms 

 

Waveforms are the visual representation of your audio. They are useful in 
editing audio by showing how high or low the levels are.  
 
The height of the waveforms can be adjusted by going to the light switch 
icon at the bottom of the Timeline that we looked at in section 2.1. 
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Soloing 

Sometimes you'll want to hear just one clip and nothing else shown on  your 
Timeline. 

 

1. Select the clip (or multiple clips) you want to Solo. 
 
2. Click the Solo icon (the letter S with headphones) on the upper right of 
the Timeline. When clicked it will glow yellow. 
 
3. All the other clips will turn gray. You will now be able to watch your 
project, but only hear the clips you have selected to Solo. 

Changing Clip Levels 
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To change the level of the entire clip: 
 
1. Drag your Select tool over the black Volume Control line. It will turn into 
the icon you see above. 
 
3. Click and move the line up to make the volume louder, down to make it 
softer. 
 
4. You will see the change in the decibel level as you drag the line up and 
down. 
 
IMPORTANT: When changing the audio levels, make sure the Audio Meter 
is NOT hitting zero, which is shown by red levels on the bars. 

Fading Audio In and Out 

You can fade the audio in or out on your Timeline. 

 

1. When the cursor hovers over a clip in the Timeline, a small Handle will 
appear at the beginning and end of a track. 
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2. Click on the Handle. The cursor will change to two arrows facing different 
directions. Drag your cursor to the right or left to fade the audio in or out. 
 
3. A box will appear, telling you how long the fade will last. 
 
4. A curved line in the audio track represents the audio fade. 
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Background Tasks 

Final Cut Pro X does a lot of work behind the scenes while you are editing. 
The program takes advantage of your computer's processing power to 
render, analyze and transcode clips. FCPX does all of this stuff in the 
background, which allows you to start working right away without having to 
wait for your clips to be processed. 

Background Tasks Window 

 

On the left side of your Dashboard (located in the middle of your Toolbar) is 
a circle with a percentage inside of it. This percentage indicates the progress 
of any background tasks FCPX is processing. By clicking on it you will open 
the Background Tasks window. 

 

When opened, the Background Tasks window shows you what tasks FCPX is 
processing in the background.  
 
IMPORTANT: You need to be aware of this, especially in the case of 
Importing Media and Sharing. Do not quit FCPX when you are importing 
media or sharing. Check the Background Tasks window before you quit to 
make sure you are not interrupting any tasks. 
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You can see the percentage of how much already has been processed in the 
Dashboard. 

 

An orange bar will appear on the top of the Timeline to signify that a 
background task is in process. 
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Text Elements 

At this point, you might want to add a lower third, a title and credits to your 
video. Final Cut Pro X has very many text generators available to you. In 
this lesson you will learn how to add basic text to your assignment. 

The Titles Browser 

 

1. On the Toolbar, select the Titles Browser icon. 
 
2. The Titles Browser will open in a window to the right of the Timeline. 
 
3. Depending on the kind of text you need to create, select the appropriate 
option in the Titles Menu. 
 
Note: The Titles Browser contains many different Titles generators that 
you can use to add text to your video. In the following lessons you will learn 
just a couple of these. Each one has different abilities and effects built in and 
are worth checking out on your own time. 
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Adding a Lower Thirds Text 

You can add the name of your subject and their identifying title to your clip 
by using a Lower Thirds. 

 

1. In the Titles Browser select the Lower Thirds option on the left side. 
 
2. Select the "Gradient - Edge" Title in the browser and drag it towards the 
Timeline. 

 

3. Drag the Title unto the Timeline where you want the Lower Third to be 
displayed. 
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4. The Lower Third will now appear in the Viewer. 

 

5. Type in the Name and the Description of your subject by clicking in the 
Text Fields. 
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6. Open the Inspector Window by clicking on the Inspector icon or by using 
the keyboard shortcut Command + 4. 
 
7. Click on the Title section of the Inspector Window. 
 
8. Under Published Parameters, adjust the title font, size and color as well 
as the background color, alignment and size of the Bar. 
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9. Select the Text option in the Inspector Window to further adjust text 
elements. 
 
10. You can also add an Outline, Glow and Drop Shadow to your text by 
clicking in the box next to the option you want to activate. 
 
11. Move the mouse over the option you have activated and click on Show. 

 

12. Make any adjustment you want. 
 
13. Click Hide to minimize the options. 
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Adding a Title 

There are many templates to use to add a title to your assignment. The 
following step shows the use of the Basic Title. 

 

1. In the Titles Browser, select the Basic Title option and drag onto your 
timeline. 
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2. Change the Text and adjust the Font, Size, Drop Shadow, etc. to your 
liking. 
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Changing Text Location 

You can change the location of your text Titles by using the Transform Tool 
in the Viewer. 

 

1. Click on the Transform tool on the lower left of the Viewer. 
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2. Click the text component and move the text around to where you want it 
to appear. 
 
3. When you are finished, click Done. 
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Additional Editing Helpers 

Markers 

 

Markers can be made on a clip, in the Timeline or in the Event Browser. They 
can be used to add notes to specific areas of the Timeline.  
To make a marker: 
 
1. Press the M key once to create a marker. A marker will appear wherever 
the Playhead is on the Timeline. 
 
2. If you want to name the marker, double click on it and type in the text 
field. 
 
3. A standard marking is indicated by the first icon. 
 
4. Click "Done" to close the Marker window. 
 
Note: Markers can be used to make notes for a specific clip. 

 

5. A Marker can be changed to a To Do item by clicking on the second icon. 
A To Do item can help in creating and organizing tasks to complete your 
assignment. 
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6. When made into a To Do Item, the marker color will change to red. 
 
7. A "Completed" check box will appear. 

 

6. The Markers can be viewed in the Timeline Index. 
 
7. Select the "Tags" tab. 
 
8. Click on the Marker icon. 

 

8. Click the To Do Item icon to view the To Do Items. 
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Play Full Screen 

 

On the bottom right of the Viewer: 
 
1. Play Full Screen - allows you to view your project in full screen mode. 
 

Right Clicking (Control Click) 

 

Right Clicking (Control Click) on a clip opens a lot more options you can 
explore later, such as Expanding the Audio and Video (explained in Section 
3.1). 
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Keyboard Commands 

You already know ... 
 
• I is for In Point. 
• O is for Out Point. 
 
A few new ones ... 
 
• J is for backward. 
• K is for stop. 
• L is for forward. (Push the previous keys twice to go faster, three times 

to go even faster.) 
• The space bar starts and stops the playhead. 
• The Home key takes you to the start of your Timeline 
• The End key takes you to the end of your project on the Timeline. 
• Command I opens the Import Window 
• The up and down arrows move you from edit point to edit point. 
• The left and right arrows move you frame by frame through the 

Timeline. 
• Command+ and Command– allow you to zoom in/out on a window. 
• Shift Z makes everything in your timeline visible. 
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Fine-Tuning 
Audio Expanded 

In Section 1.7 you learned the basics of edtiting audio. This lesson will 
explore more options in how to sweeten your audio. 

Editing Audio in the Inspector 

 

The Inspector window can provide additional options and control when it 
comes to making your audio sound better.  
 
1. Highlight the clip you want to adjust in the Timeline.  
 
2. Click the Inspector icon on the far right side of the toolbar. 
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3. Click on the "Audio" tab on the top of the Inspector window. 
 
4. Volume and Pan. You can control the overall volume and pan (balance 
betwee left and right speakers). 
 
5. Audio Enhancements. You can change the Equalization of the audio 
here.  
 
6. Audio Analysis. Click on the arrow to analyze your audio for any 
problems. 
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The Audio Analysis will alert you if there are any potential issues with the 
audio. 
 
7. Loudness. If the clip is not loud enough a warning symbol will appear, as 
shown above. 
 
8. Background Noise Removal. This will determine if there's too much 
noise happening in the background, such as an air conditionar or traffic. 
 
9. Hum Removal. This will help to remove any hum from electrical 
currents. 
 
10. Auto Enhance. Clicking this will automatically make any adjustments 
FCPX identifies in your audio. 
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11. Click the box next to the Enhancement you would like to apply to your 
audio. In the example above, FCPX has now increased the audio levels based 
on its analysis. 
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EXPAND AUDIO/VIDEO 
The Expand Audio/Video function allows you to edit audio and video 
separately from each other while still keeping them synced together. 

 

1. Select the clip you want to edit, right click, and select "Expand Audio / 
Video" or use the keyboard shortcut control + S. 

 

2. Drag the end of the audio clip to the left, underneath the preceding clip. 
This allows the audio of the "Elevator - Inside" clip to be heard before the 
viewer sees the video. This type of edit is called a J-Cut. 
 
NOTE: The audio and video components are still colored blue, meaning that 
they are still one clip, with the audio synced to the video. 
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3. Right click on the clip and a select "Collapse Audio/Video" or control + S 
to have the audio and video appear together in one clip. 

 

4. By expanding the clip on the left and draging the audio to the right, you 
have created an L-Cut. The audio will still be heard as the viewer sees the 
"Elevator - Inside" clip play on screen. 

DETACH AUDIO/VIDEO 
Often confused with Expand Audio/Video, Detach Audio disconnects the 
audio from the video, creating two separate clips and allowing them to 
become out of sync. 
 
This function should only be used if you want the audio to NOT match with 
the video. 
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1. Right click on the selected clip and select Detach Audio, or use the 
keyboard shortcut control + shift + S. 

 

2. The audio and video are now separate clips, with the video colored blue 
and the audio is now colored green to signify an audio clip. 
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3. The audio clip can then be dragged along the timeline as a Connected 
Clip. But now the audio will not be in sync with the video. 

KEYFRAMES 
Keyframes are used to change the levels on a specific part of the audio. 

 

1. Hover your mouse over the black audio line while pressing the Option key. 
A white diamond will appear, which is the Keyframe icon. 
 
2. Click on the black audio line to create a Keyframe. Create other 
Keyframes on the audio clip, as shown above. 
 
3. Click on the black audio line in the middle of the Keyframes to lower the 
levels of that section. 

 

4. To delete a Keyframe, click on the diamond icon and press the delete key. 
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5. The above example shows fading out a music track using Keyframes that 
fades out at the end of the clip. 

The Range Selection Tool 

A quick way to create Keyframes is to use the Range tool. 

 

1. Under the Tool selection drop-down menu select the Range Selection 
tool, or use the keyboard shortcut R. 
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2. Click and drag over the area you want to adjust in the clip on the 
Timeline. 

 

3. Click on the black audio line within the selection and change the audio 
levels. 
 
4. Click somewhere else in the Timeline to deselect the range and see the 
Keyframes that were created. 
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Sub-Frame Audio Editing 

Sub-frame audio editing allows you to change the IN or OUT points between 
frames. 

 

1. In the Editing preferences (as shown in Section 1.2) select the Time 
Display dropdown and select the HH:MM:SS:FF + Subframes option. 

 

2. Select the clip you want to edit, right click, and select "Expand Audio / 
Video" or use the keyboard shortcut control + S. 
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3. Grab the end of the audio to trim IN or OUT. The Sub-frames are now 
displayed. 
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Visual Editing Expanded 

FCPX offers many great tools and options to enhance the visual aspects of 
your assignment. 

EDIT BUTTONS REVISITED 
Previously, you learned about the Append Edit button. The other two 
buttons, Insert and Connect, can be just as helpful in editing your project. 

Insert Button 

 

The Insert button allows you to place a clip into the Primary Storyline on the 
Timeline whever your Playhead is. 
 
1. Select a clip or portion of a clip in the Event Browser (As shown in section 
1.6). 
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2. Position the Playhead on the Timeline where you would like to insert the 
clip. 

 

3. Click on the Insert button, or use the keyboard shortcut W. 
 
4. The selected clip is now on the Timline, inserting itself in the middle of the 
clip that was already there. 
 
Note: Make sure the Playhead is where you want the Insert to happen. This 
will split clips already on the Timeline. 

Connect Button 

 

The Connect button allows you to attach a clip above a clip on the Primary 
Storyline in the Timeline. This is useful for placing B-Roll into your project. 
 
1. Select a clip or portion of a clip in the Event Browser (As shown in section 
1.6). 
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2. Position the Playhead on the Timeline where you would like to connect the 
clip. 
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3. Click on the Connect button, or use the keyboard shortcut Q. 
 
4. The selected clip is now on the Timline, attatching itself to the clip that 
was already there in the Primary Storyline. 

 

5. You can build a sequence of B-Roll by continuing to use the Connect 
button. 
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GAP CLIPS 
A Gap Clip is used to create a blank space between two clips on the 
Timeline. 

 

1. Place your Playhead in location you want your Gap Clip to appear. In the 
example above the Playhead is placed between two interview clips. 
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2. In the Edit menu on the top of the screen, select "Insert Generator" and 
"Gap." The Keyboard shortcut is option + W. 
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3. A dark gray Gap clip will now appear where your Playhead is. 
 
4. The Gap clip can be trimmed just like a normal clip in the Timeline. 
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COMPOSITING: OPACITY 
This function is used to Fade In/Fade Out your video as well as to adjust the 
opacity of a clip. 

Fade In/Fade Out 

 

You learned how to Fade In/Fade Out using a Cross Dissolve in section 2.1. 
There is another way to do this. 
 
1. In the clip you want to Fade In, right click and select "Show Video 
Animation" or use the keybord shortcut control + V. 

 

2. Select the "Show Video Animation" option in the drop-down menu. 
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3. In the Video Animation menu, select the drop-down arrow under 
"Compositing: Opacity." 

 

4. Grab the left handle in the "Compositing: Opacity" window and drag it to 
the right. A diagonal black line will appear, showing that the video is fading 
in. 
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5. The numbers in the box above shows how far into the clip the video is 
fading in. In the scenario above, the video takes two seconds and two 
frames to go from black to full opacity. 
 
6. The handle on the right can be used to Fade Out a clip. 

Opacity 

You can adjust the opacity of a clip, so that the clip underneath is visible. 
 
1. Select the clip you want to change the opacity on. 
 
2. As show above, open the Video Animation menu, or use the keyboard 
shortcut control + V. 

 

1. Hover your cursor over the black line running along the top of the menu. 
 
2. Click on the line and drag down. This effects the opacity for the entire 
clip. 
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The screen above shows what the image looks like after the opacity of the 
top clip was brought down to 82%. 
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KEYFRAMES 
Keyframes allow you to change a specific area within a clip. For example, 
you can use Keyframes to change the opacity of a portion of a clip. 

 

1. In the Compositing: Opacity window, hold down the Option key. Your 
cursor will change to the Select tool with a diamond icon. That is the 
Keyframe symbol. 
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2. Click on the area of your clip where you want the opacity to start to 
change. 

 

Note: Keyframes are always used in pairs.  
 
3. Create three more keyframes, demonstrated in the screen above. 
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4. Click on the portion of the black line BETWEEN the two sets of 
Keyframes. 
 
5. Drag the cursor down to lower the opacity for that one section. 
 
Now the opacity will be lowered for only that one portion of the clip. 
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TRANSFORM EFFECT 
As seen in Section 2.4, the Transform tool can be used to move Text 
elements around the Viewer. It can also be used to enlarge video clips in the 
Viewer, as shown below. 

 

1. In the Timeline, select the clip you wish to enlarge. 
 
2. In the Viewer select the Transform tool from the drop-down menu. 
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3. You may need to change the size of the clip in the Viewer so that the 
entire clip is visible. 

 

4. Select a blue dot on the corner of the clip in the Viewer. Drag the mouse 
towards the edge of the viewer to increase the size of the clip. In the 
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example above, you can see that the white chair on the bottom left of the 
screen is not visible anymore. 
 
5. When finished resizing the image, click Done. 
 
Note: This should be used in moderation. Increasing the size of the clip too 
much will result in a degraded image quality. 

CROP EFFECT 
The Crop effect can be used in a variety of ways. The following lesson will 
focus on using the Crop effect to add movement to still images. 

 

1. In the Timeline, select the still image you would like to add movement to. 
 
2. In the Viewer select the Crop tool from the drop-down menu. 
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3. On the bottom of the Viewer, select the Ken Burns effect. 
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4. Move the green Start box into the position you want your image to be 
when it shows up on screen. 
 
5. Move the red End box to where you want the image zoomed into. 
 
6. The movement can be previewed by pressing the preview play button on 
the top left of the viewer. 
 
7. When finished click Done. 
 
Note: The speed of the zoom is determined by the length of the clip in the 
Timeline. If you want the zoom to be faster, make the clip shorter. If you 
want the zoom to last longer, make the clip longer. 

RETIME TOOL 
The Retime tool is used to speed up or slow down the speed of a clip, plus 
make a freeze frame, among other things. 

Increasing Speed 

 

1. Select the clip you want to display faster than real time. 
 
2. Go to the Retime tool and select Fast and the desired speed. 
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3. The clip will now have the Retiming window above it in the Timeline. 
 
4. The speed can then be adjusted by grabbing the edge of the blue bar and 
moving the mouse left or right to make it faster or slower, respectively. 
 
 

 

5. The clip can be changed back to Normal speed by clicking on the drop-
down arrow in the middle of the blue bar. 
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Decreasing Speed 

 

1. Select Slow and the desired speed from the Retime Tool. 

 

2. The clip will now have the Retiming window above it in the Timeline. 
 

 
3. The speed can then be adjusted by grabbing the edge of the orange bar 
and moving the mouse left or right to make it faster or slower, respectively. 
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4. The clip can be changed back to Normal speed by clicking on the drop-
down arrow in the middle of the orange bar.  

Hold 

The Hold function creates a freeze frame on a specific frame of a clip for a 
certain amount of time. 

 

1. In the Timeline place the Playhead in at exact point in the clip in which 
you wish to freeze the image. 
 
2. In the Retime tool select Hold. 
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3. A red Hold bar will now appear above the clip. 

 

4. Click and drag the edge of the red bar to the left or right to make the 
Hold last shorter or longer, respectively. 
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CREATE A FREEZE FRAME 
In addition to the Hold feature, you can also create a Freeze Frame that 
becomes a separate clip. 

 

1. Place the Playhead over the exact spot on the clip you wish to freeze. The 
desired frame should appear in the Viewer Window above. 
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2. Click on Edit in the top menu. 
 
3. Select Add Freeze Frame (Option + F ). 

 

4. The Freeze Frame will now appear in the Timeline as a new clip. 
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EXPORTING A STILL FRAME 
You are able to export a single frame out of FCPX as a still frame. 

 

1. Select the Share Icon in the Toolbar. 
 
2. Click the Add Destination tab in the drop-down menu. 
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3. Select the Save Current Frame icon. 
 
4. Drag it into the Destinations column on the left side of the Destinations 
window. 
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5. In the Timeline place the playhead over the frame you would like to 
export. 
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6. Select the Share Icon in the Toolbar. 
 
7. Click on Save Current Frame. 

 

8. With the Info tab highlighted blue update the Name, Description, Creator 
and Tags sections. 
 
9. Click the Settings tab. 
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10. In the Export drop-down select which file format you would like to use. 
In the example above the format was changed to JPEG. 
 
11. Check the box for "Scale image to preserve aspect ratio." 
 
12. Click Next. 

 

13. Select the folder in which you would like to save the exported still frame. 
 
It is recommended that you save the file to your External Hard Drive and the 
Assignment Materials Folder in which all of your assets for this particular 
assignment are located. 
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In the example above the still frame is exported to the OUTPUT folder since 
it is being exported out of FCPX. 
 
14. Click Save. 
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Video Color Correction 

Color correction can be a very involved process. The following lesson will 
show be a basic guide to correcting color in your assignment. 

Getting Started 

 

1. In the Timeline, place the playhead over the clip you want to correct, 
making it visibile in the Viewer. 
 
2. Open the Inspector window. 
 
3. Make sure the "Video" tab of the Inspector is selected.  
 
4. You will be using the "Color" section of the Inspector to make your 
adjustments. 

Balance Color 

The Balance function will automatically adjust the white balance of your clip. 
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1. Click on the box next to "Balance" to turn on the setting. The box will be 
highlighted blue when turned on. You can turn the setting on and off to see 
the difference between the two color settings. 
 
The reason it says "Not Analyzed" is because you turned off the Analyze 
function during the initial Import. The next step will show you how to 
analayze a clip after import. 
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2. Find your clip in the Event Browser 
 
3. Right click (or Control click) on the clip and select "Analyze and Fix." This 
will analyze the color settings for the selected clip. 
 
Note: It is not necessary to analyze every singe clip you wish to color 
correct. It does help in getting a more accurate color balance though. 

Video Scopes 

Video Scopes are used to determine how much color and exposure 
correction a specific clip needs and are very helpful in color correction. 

 

1. Click on the light switch on the top right of the Viewer. 
 
2. Select "Show Video Scopes." 
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3. In the window that opens, click on the "Settings" tab on the right. 
 
4. Select "Waveform." With this displayed you can see the Luma values 
change as you are making adjustments to the color, exposure and saturation 
of a clip. 
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CORRECTION 

 

1. In the Inspector, click on the arrow in the "Correction 1" box. 

Exposure 

The Exposure window allows you to control how light and dark your clip is. It 
is best to add some contrast first before you do too much color correcting. 

 

1. In the Color Adjustment window, select the Exposure tab. 
 
2. Global exposure. This controls the overall exposure of the clip. Move the 
slider up for a brighter image or down for a darker image. 
 
3. Shadows. Adjusts just the dark areas of the clip. Move the slider up for 
lighter shadows or down for darker ones. 
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4. Mid Tones. Adjusts just the middle areas of the clip. Move the slider up 
for lighter mid tones or down for darker ones. 
 
5. Highlights. Adjusts just the highlights of the clip. Move the slider up for 
brighter highlights or down for darker ones. 
 
6. Waveform. The basic idea is to keep all colors and light of the clip to stay 
between 0 and 100. Look at the Waveform when adjusting the sliders to 
make sure the spectrums don't go below 0 or above 100. 

Color 

The Color window allows you to adjust the color cast of your clip. For 
example, if your clip is very yellow or very blue, you can use this function to 
make the color balance more neutral.  

 

1. In the Color Adjustment window, select the Color tab. 
 
2. Global color. This controls the overall color cast of the clip. Move the 
slider up for more of specific color or down for less of a specific color. 
 
For Example: If your clip is very blue, you woule drag the slider to the blue 
on the color bar and move it down, to take away the blue color. 
 
3. Shadows. Adjusts just the dark areas of the clip.  
 
4. Mid Tones. Adjusts just the middle areas of the clip.  
 
5. Highlights. Adjusts just the highlights of the clip.  
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6. Waveform. The basic idea is to keep all colors and light of the clip to stay 
between 0 and 100. Look at the Waveform when adjusting the sliders to 
make sure the spectrums don't go below 0 or above 100. 

Saturation 

Saturation is how vibrant the colors are in your clip. 

 

1. In the Color Adjustment window, select the Saturation tab. 
 
2. Global saturation. This controls the overall saturation of the clip. Move 
the slider up for more of vibrant color or down for muted color. Dragging the 
slider all the way down will create a black and white image. 
 
3. Shadows. Adjusts just the dark areas of the clip.  
 
4. Mid Tones. Adjusts just the middle areas of the clip.  
 
5. Highlights. Adjusts just the highlights of the clip.  
 
6. Waveform. The basic idea is to keep all colors and light of the clip to stay 
between 0 and 100. Look at the Waveform when adjusting the sliders to 
make sure the spectrums don't go below 0 or above 100. You can see the 
intensity of the colors change when you adjust the sliders here. It is showing 
you how much of a color is there. 
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Finished with Corrections 

 

1. Click on the arrow in the Adjustment Window to go back to the Inspector 
Window. 

 

2. You can turn the "Correction 1" effect on and off to see if you like the 
changes you made. 
 
3. You can reset the correction settings by clicking on the Reset icon. 
 
4. To make additional corrections, click on the addition icon. 
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Finishing Up 
Sharing 

Sharing is the process of getting your video out of FCPX into a file that can 
be viewed on your computer or other device. There are many different ways 
to share and compress your video depending on where it will be viewed. The 
following lesson will show one basic way of sharing your video. 

Preparing your Project 

 

Before you share your video, make sure that your Project Timeline contains 
all of the clips you want in your final video. 
 
The Share process will include everything on your Timeline, so if there is a 
sequence at the end of your Timeline that you don't want in your final 
product, you will need to delete it. 
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Sharing to H.264 

 

1. On the top menu, click on File. 
 
2. Select Share. 
 
3. Select Master File (default) or use the keyboard shortcut Command + E. 
 
OR 
 

 
4. Select the Share Project icon on the far right side of the toolbar and click 
the Master File (default) option. 
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5. Select the Settings tab (it will be highlighted blue when selected). 
 
In the Master File menu make sure the settings match the ones in the above 
screen: 
 
6. Format: Video and Audio 
 
7. Video codec: H.264 
 
8. Open with: QuickTime Player 
 
9. Roles as: QuickTime Movie 
 
10. Click Next 
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11. Save As: The naming convention your instructor has told you to use. Use 
one of the following conventions: 
 
     A. TEAM NAME - ASSIGNMENT NAME 
    Example: TEAM A - FICTION 
 
    B. LAST NAME - ASSIGNMENT NAME 
      Example: SMITH - FICTION 
 
    C. DATE (year first) - ASSIGNMENT - YOUR NAME 
     Example: 2012_06_21_FICTION_JOHNSMITH 
     
12. Select the OUTPUT folder under your Assignment Materials folder on 
your External Hard Drive. 
 
13. Click Save. 
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The Sharing process will now appear in the Background Tasks window. You 
will be able to continue to work in Final Cut while the Project is Sharing.  
 
IMPORTANT: DO NOT close down FCPX while Sharing is taking place. This 
will cause problems with your finished video file. 
 
Note: The length of Sharing depends on the length of your project as well as 
the complexity. It is always a good idea to plan accordingly and start sharing 
with plenty of time before the assignment is due. Do not wait until the last 
minute to Share, as it can often take longer than you want it to. 
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Reconnecting Broken Links 

FCPX keeps track of the specific location of your clips and what you name 
them. If you move or rename a clip via the finder, FCPX will no longer know 
where it is or recognize the new name. 

 

If FCPX loses track of a clip, it will turn red and say “Missing File” in the 
Viewer. 

 

A warning symbol will appear on the Event name in the Event Library. 
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The clips in the Browser also will change to red and say "Missing File." 

Relink a file to its assset on the hard drive 

 

1. Right click (Control click) on the Event that has the missing files. Select 
"Relink Event Files." 
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2. In the Relink Files window select "Locate All..." 
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3. Locate the files on your external hard drive. Since you have been storing 
everything in your Assignment Materials folder, that's where the files 
should be. Click Choose. 

 

4. When the files have been matched up with the links, click Relink Files. 
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Recovering Missing Projects and Events 

When working in the Newhouse labs, it is essential that you create Events 
and Projects on your own External Hard Drive. If, however, you forget to do 
so and instead create the Events and Projects on the internal hard drive of 
the lab computer (Macintosh HD), those files may still be recoverable. 
 
IMPORTANT: Do NOT rely on this method if your Events and Projects go 
missing. The following lesson can help recover the missing Events and 
Projects, but does not guarantee it. 

 

 
 
 

If you launch Final Cut Pro X and your Event and Project Libraries look like 
the screens above, your existing Event and Project may be located on the 
Macintosh HD of the computer you were working on when initially creating 
the Events and Projects. 

Lost & Found 

On each of the lab computers there is an archive of files that have been 
created on it in the last seven days. This archive is a folder titled 
Lost_&_Found. You must be logged into the computer that you were using 
when initially creating the Event and Project that is missing. 
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1. It is best to quit out of FCPX by going to File > Quit or using the keyboard 
shortcut Command + Q. 

 

2. Navigate to the Spotlight in the top right corner of the screen. 
 
3. Type in Lost_&_Found.  
 
4. Click on the folder that appears in the drop-down menu to open the 
archive. 
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5. Scroll through the list of names to find your user name and the date in 
which you were using that computer. 

 

6. In that folder, select the Movies folder. Inside is a Final Cut Events and 
Final Cut Projects folder. 
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7. Open the Final Cut Events folder and drag the Event folder into the Final 
Cut Events folder on YOUR External Hard Drive. 

 

8. Open the Final Cut Projects folder and drag the Project folder into the 
Final Cut Projects folder on YOUR External Hard Drive. 

 

9. Launch FCPX and make sure that your Event and Project are now located 
underneath your External Hard Drive in the Event Libraries, as shown above. 
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